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Release Notes for RobotStudio 2022.1

General

The release name is RobotStudio 2022.1 and the build number is 22.1.9826.0. The release date is March
29, 2022.

User documentation

The RobotStudio Operating Manual is available in all languages except Czech, i.e. English, German,
French, Korean, Chinese, Japanese, Spanish. A selected set of RobotWare manuals are available. Each of
them is available in two versions, one for IRC5 and one for OmniCore.

Tutorials

Tutorials are available at the RobotStudio product pages at http://www.abb.com/roboticssoftware.

System Requirements

Required Software

Microsoft Windows 10 Anniversary Edition or later, 64-bit edition, is required.

The Windows AppInstaller is a pre-requisite for the virtual OmniCore FlexPendant software, see
https://www.microsoft.com/en-us/p/app-installer/9nblggh4nns1. The App Installer is a default built-in
app in Windows 10, but may have been removed on some PCs.

Sideloading of apps must be enabled on Windows 10 to install the virtual OmniCore FlexPendant.

To enable sideloading follow these steps:

1. Open Settings.

2. Click Update & Security > For developers.

3. Under Use developer features, select Sideload apps or Developer mode.

Recommended Hardware

ITE M RE QUIRE ME NT

CPU 2.0 GHz or faster processor, multiple cores recommended

Memory
8 GB minimium
16 GB or more if working with large CAD models

Disk 10+ GB free space, solid state drive (SSD)

Graphics
Card¹

High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors.
For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.

Screen
Resolution

1920 x 1080 pixels or higher is recommended

Mouse Three-button mouse

3D Mouse Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com.
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Virtual
Reality
Headset

Oculus Rift, HTC Vive or any Windows Mixed Reality Headset. Note that special PC hardware
requirements apply when using RobotStudio with VR, see https://www.oculus.com/oculus-ready-
pcs/, https://www.vive.com/us/ready/, or,
https://www.microsoft.com/enus/windows/windows-mixed-reality-devices, respectively.

ITE M RE QUIRE ME NT

¹ RobotStudio will not benefit from the additional features of so-called ‘Professional’ or ‘Workstation’
graphics cards. The price level of these are at a much higher range than gaming graphics cards with
comparable performance. High-end gaming PCs are very suitable for offline programming with
RobotStudio. Such a PC will provide good performance for a limited budget.
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New Functionality

Can configure PROFINET Controller and PROFINET Device on different network interfaces

CC-Link Device

Copy joint values to clipboard as jointtarget text

Copy TCP to clipboard as robtarget text

Copy/Apply position and orientation

Create part from Work Envelope

File - Open page

IRB 1300-12kg/1.4m

IRB 920T IP54/Clean Room

Sample stations available from the Open page

Visual SafeMove: Possible to decouple emergency stop output

Can configure PROFINET Controller and PROFINET Device on different network interfaces

The PROFINET Controller and the PROFINET Device can now be configured on different ports, i.e. Public
Network (WAN) and I/O Network (LAN), in the I/O Engineering in RobotStudio.

CC-Link Device

CC-Link device can now be configured in IO Engineering part of RobotStudio.

Copy joint values to clipboard as jointtarget text

Added a context command to robots for copying the current joint values to the Windows clipboard as a
RAPID jointtarget declaration. External axes joint values are included for activated units.

Copy TCP to clipboard as robtarget text

Added a context command to robots for copying the current coordinates of the active TCP to the
Windows clipboard. The coordinates are copied in relation to the active workobject and as a RAPID
robtarget declaration.

Copy/Apply position and orientation
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The functionality for copying the position/orientation from one object and applying it to another has
been improved.

All objects with position and orientation are supported.
Choose if the copied position/orientation is in relation to the world coordinate system or the
object's parent's coordinate system. The same reference will be used when applying the
position/orientation. 
It is possible to apply position, orientation or both the position and orientation. 

Create part from Work Envelope

Added a button in the Work Envelope window for adding the generated work envelope to the station as
a part. The part is saved in the station and can be exported as any geometry.
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File - Open page

In the File menu, the Open and Recent commands have been merged into a new Open page.

IRB 1300-12kg/1.4m

The IRB 1300 12kg/1.4 m variant has been added to ABB Library. It is supported from RobotWare 7.6.

IRB 920T IP54/Clean Room

The IRB 920T IP54/Clean Room variant has been added to ABB Library. It it supported from RobotWare
7.5.
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Sample stations available from the Open page

Sample stations have been moved from the RobotStudio installer to cloud storage to reduce the size of
the distribution and allow independent updates.
The sample stations can be downloaded from the File - Open page.

Visual SafeMove: Possible to decouple emergency stop output

From RobotWare 7.6, it is possible to decouple the external emergency stop from the emergency stop
output in order to not cause dead-locks.
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Improvements

"Comments" renamed to "Change Log" in Save As dialog

In the Save As dialog, the text box label was changed from "Comments" to "Change Log" to clarify that
the text corresponds to a Change Log entry in the station information.

"Include safety settings" checked by default

The setting "Include safety settings" is now checked by default in the Unpack & Work wizard.

OmniCore support for IRB 1200

Added support for creating OmniCore virtual controllers for IRB 1200 in RobotStudio.

Permanently hide "View Robot at Target" notification

Added a button in the "View Robot at Target" notification menu to hide the notification permanently.
The notification can be restored by selecting "Restore hidden dialogs and messages" in Options.

Restart dialog after installing a package

The user will now be prompted to restart RobotStudio after installing a package from the add-ins tab.

Tooltip on Default Gateway in I/O Network dialog

Added a tooltip that informs the user that the default gateway can only be set from the 'Public network'
configuration and is shared between the public and the I/O network interfaces.

Visual SafeMove: Support for rotated CRB 15000 robot

Visual SafeMove now supports none zero gravity parameters in the Safety Configuration for CRB 15000
(GoFa). RobotWare 7.5 or higher is required. 
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Information

Camera Emulator Removed from Integrated Vision in RobotStudio

Camera Emulator is removed from Integrated Vsion in RobotStudio.
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Corrections

PDD

12926

Online Monitor shows incorrect layout for IRB 6620LX

Online Monitor now correctly displays IRB 6620LX in situations where Task Frame and Base Frames have
been changed from their default values.

13309
FlexPendant Viewer chapter missing in Robotstudio Operating Manual

Added the previously removed FlexPendant Viewer chapter back to the RobotStudio Operating Manual.

13497

Special characters in UAS password not accepted

Corrected the validation of password characters when creating a user on an IRC5 controller. The
password is now checked for unsupported characters such as & and " before it is sent to the controller.

14049

Gearbox heat prediction does not support IRB660 and IRB460

The error message will now give the actual cause for IRB660 and IRB460 not working with the add-in,
which is that "Fan upgrade for this robot model is not available."

14081

TCP trace: Maximum trace length too short

The maximum length in TCP trace was not enough for a long lasting simulation. It has now been
increased from 1 km to 90,000,000 km.

14118

Not possible to free hand jog joint 3 of IRB 920T

The IRB 920T IP30 simulation models have been updated to enable freehand jogging of both axis 3 and
axis 4.

14158

OPC UA Client connection failure

The timeout for finding an OPC UA server was set to 1 second in the OPC UA Client Smart Component.
This could lead to connection failures when trying to connect to a distant server with a lot of latency.
The timeout has now been increased to 5 seconds.

14168

OPC UA Client doesn´t synchronize signals after Reset

Fixed a bug that caused the OpcUaClient Smart Component to stop synchronizing signals when
clicking the Reset button in the Simulation tab.

14177
Elevated rail length is missing in RobotStudio

14195

Exception when adjusting robtargets

Fixed an exception that could happen when using the Adjust Robtargets functionality or when opening
a RAPID module. The issue only occurred if there was a RAPID module with an ELSEIF statement having a
numeric literal directly followed by a keyword without whitespace in-between.
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14205

Category not validated in "Add Signals" dialog

The Category attribute of a signal must follow the same rules as a RAPID identifier. This was however
not enforced by the "Add Signals" dialog. The dialog now validates the Category attribute before
enabling the OK button.

14237

Recent UAS users not stored

When logging in to a controller using the "Log in as a Different User" menu item the user name was not
stored in the Recent Users list (File > Options > Online > Authentication & Language) and was not shown
in the User Name dropdown list in the login window. This has now been corrected.

14261

Misaligned animation in glb file

Fixed errors in the animation when a glTF file is exported from a complex simulation where Smart
Components are used to modify the object hierarchy.

14319

I/O view device filter not working

Fixed an issue where it wasn't possible to filter on devices that had slotted child devices. Selecting a
"parent" device will now show all IOs belonging to its child devices.

14394
Fatal exception when rotating graphics view

Fixed a bug where RobotStudio would crash when rotating the view after selecting top or bottom view

Exception when logging in as "admin" user on RobotWare 6.x Virtual Controller

RobotStudio now verifies the credentials when logging in to a RobotWare 6.x Virtual Controller. Earlier
any combination of username and password was accepted, leading to unexpected behavior.
Note that there is by default no "admin" user on a RobotWare 6.x controller.

Visual SafeMove: No error when assigning a writer to an input signal

Now there will be an error in the I/O node when assigning a writer to an input signal

Rapid: No message shows on clicking on new declaration link to a blank module

title: Issue with new declaration in RAPID Data Editor
New Declaration hyperlink in RAPID Data Editor has been updated. It now gets disabled and gets a tool
tip showing disabled reason when no valid RAPID type is chosen by the user.

Visual SafeMove: Assigned signal to Stop Configuration not auto protected

Visual SafeMove has been updated making sure a protection of a Stop Configuration also automatically
protects its assigned signals.

Visual SafeMove: SafeRanges removed after writing to Stand Alone Controller.

SafeRanges are no longer removed after writing to Stand Alone Controller.

Visual SafeMove: Wrong corner angle values in error message

Error message values for the limit of a corner angle is now shown correctly in Visual SafeMove.

PDD
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Wrong English to German translation in Cross connection tool

Corrected some German translations in I/O Engineering Tool.

OPC UA Client disconnected when adding object to station

Fixed an issue that caused all instances of the OpcUaClient Smart Component to become
disconnected when an object was added to the station.

IRB 910INV: Jogging top part of J3 moves J4.

Fixed an issue with freehand joint jog in the IRB 910INV (IP30) simulation models. 

TCP Trace: IRB 14050 category 0 stop position not displayed

Fixed an issue with stop position trace for IRB 14050.

Not possible to set default gateway to 0.0.0.0

0.0.0.0 is now an allowed IP address for Default Gateway

Incorrect dialog placement when scaling is enabled

Fixed an issue where the placement of dialogs was not restored correctly in a multi-display
environment with differing scale settings.

Export and import of 2D work envelope fails

Disabled export of wire objects such as a 2D work envelope to graphics formats that only support
triangle primitives.
Added support for wire primitives to glTF export.

Visual SafeMove: Base Frame not updated with data from controller when creating new controller
configuration

Now Base Frame is updated with data from controller when creating new controller configuration.

Visual SafeMove: Missing trigger signal not validated in Stop Configurations

A missing trigger signal in a Stop Configuration will now generate an error.

Network settings, Actual port speed

Added a read-only label below the port speed drop-down that shows the actual port speed on the
network interface which can differ from the configured port speed if the network switch does not
support the set speed.

F1 in RAPID Editor opens IRC5 manual instead of 

Ensured that the correct RAPID reference manual, IRC5 or OmniCore, is opened when using context
sensitive help in the RAPID editor.

PDD
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Visual SafeMove: Not possible to configure a M17 device when the configuration already has a
PROFIsafe device

Now it is possible to configure M17 device when the configuration already has a PROFIsafe device

Visual SafeMove: Exception when switching between I/O Engineering Tool and Visual SafeMove

When configuring devices in I/O Engineering Tool and switching window to Visual SafeMove an
exception was thrown when using RobotWare 6. This has now been fixed.

PDD
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Known Limitations

Visual SafeMove

E10 virtual controller not supported

It is not possible to create a valid safety configuration file for a virtual controller where the controller
model is E10. The device mapping of signals on the internal feedback device will be incorrect. There is no
information about this limitation inside Visual SafeMove because it is currently not possible to know the
model of a virtual controller.

Configurations with Basic Joint Supervision disabled can be created

For SCARA robots, like for example IRB 920T, only the limited functionality Basic Joint Supervision is
supported by the Safety Controller. Visual SafeMove allows the full set of functionality to be configured
even though it is not supported. Writing a safety configuration file with Basic Joint Supervision disabled
results in an error since it is invalid. Workaround: Enable the option Basic Joint Supervision on the robot
node in Visual SafeMove.

Current joint values cannot be retrieved when external axes are included in the configuration

It is not possible to retrieve the current joint values using the Read current values function on the
Synchronization node when external axes are included in the configuration. Workaround: Read the
values from the FlexPendant and update manually.

The safety controller is not forwards compatible

When writing a safety configuration file of a later version than the current safety controller image, then
RobotStudio will generate an error of type “C00FFFE: Unknown error
(0xC004FFFE)LoadSafetyConfigurationFile”. (Note that this error may occur for other reasons as well
and is thus not unique to this case).

The function Get vectors from active tool reads values from the robot

The idea behind this function is to to read the data from the currently active tool of the robot in order
to define a corresponding SafeMove Tool in the safety configuration. That is the reason why the tool
information is read from the robot and not the safety controller. The tools of the safety configuration
are visible the Visual SafeMove itself and does not need a special function to be retrieved.

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06

The protected checksum will change if the input and output modules of the internal device is protected.
The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro

When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be
no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command
Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external
axes or positioners. As a consequence, the Online Monitor may show the robot in a non-violating
position, even though the safety controller has detected a safety violation and stopped the robot.
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IO Configurator 6

*Safety configuration problem with PROFIsafe Controller or CIP-Safety scanner

Changing safety settings in Visual SafeMove or IO Configurator 6 does not always work in conjunction
with the "PROFISafe controller" or "CIP-Safety Scanner" option. Connection with robot controller can be
lost during any IO-configuration, sometimes resulting in that the Flex Pendant reboots. Again this is only
applicable when the PROFISafe controller or CIP-Safety scanner option is present in the system. Problem
is dependent on how many devices are configured on respective industrial network. I.e. EtherNet/IP or
ProfiNet.

Online

Port speed cannot be set at the same time as 'Obtain IP address automatically'

In the Public Network settings dialog the Port speed drop down menu is disabled when 'Obtain IP
address automatically' is selected.

Workaround:

1. Select 'Use the following IP address' and specify any valid IP address.
2. Select the desired port speed and press OK.
3. Select 'Obtain IP address automatically' and press OK.

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later.

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later. However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to
stop can be selected from RobotStudio RAPID tab.

FlexPendant Viewer running with automatic reloading

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time
jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

Online – Paint

Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system
when running RobotWare 5.xx. Workaround: Create the backup of the PIB board with the FlexPaint
Pendant using an USB-stick.

Go Offline does not work for Paint systems

The Go offline function will not create a working Virtual controller system for Paint system unless the
Paint package I/O option is set to Simulated.

Online – Integrated Vision

Installation error when having previous versions of RobotStudio or Insight Explorer

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new
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version of RobotStudio may result in the following error message

Module C:\Program Files (x86)\Common Files\Cognex\InSight\5.7.1674.0\CvsInSightDisplay.ocx failed
to register. HRESULT -2147220472. Contact your support personnel.

Workaround: To correct the issue, open Windows Settings -> Apps -> Apps & features, select the
current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select
Repair. Alternatively, uninstall and reinstall RobotStudio.

Note: Only one version of the In-Sight Display Control can be registered at a time, and this is always the
latest version installed. Although older versions of RobotStudio or In-Sight may seem to function with
this version installed, their compatibility with this version is not guaranteed.

RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated
Vision jobs with the tool PatMax 1-50.

Workaround: Use PatMax 1-10 instead

Remaining error – New Emulators

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of
these new models are not yet fully compatible. Our recommendation is to choose a camera model from
the 7000 series which is fully compatible with Firmware version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the controller is in
Motors On. As a consequence, the camera nodes will not appear in the controller browser.

Workaround: Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision
node in the browser to make the cameras appear.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for
a specific camera model, then the newest version available shall be used. There are two important things
to know before upgrading a sensor:

The user must make sure to first backup the files on the camera. This can be done using the Rapid
snippets for camera backup/restore, or the FlexPendant Explorer.
The latest available firmware version may vary across sensor types. However, when the firmware
update utility presents the latest available version it shows the firmware with the highest version
number which may not apply to the sensor to be updated. However, the appropriate firmware will
be applied.

Information – The spreadsheet view

The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”,
“Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or
Output to Rapid.

Information – Calibration board without fiducial

When using the calibration boards, checkerboard or board with dots, the user must select the preferred
origin by clicking and accepting (press enter) three points on the board. Only after these three points
have been selected it is possible to click "calibrate" to execute the calibration.
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Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions
return error code “Communication Error”. The safest method to get default settings is to go to
Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click
“Apply factory settings” in the lower right corner. The most important settings are:

Telnet port: 23
User: "admin"
Password: ""

Information – User Credentials

It is now possible to create user profiles with different access levels on the camera. For detailed
information about this, please refer to the Integrated Vision User Manual.

Remaining error – Save image on camera

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog
still allows the user to try to do this. The result is that the image is not saved and no error message is
given.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is
not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In

Remaining error – VC started from Controller->Add controller does not detect cameras

A VC that is started from Controller->Add controller does not detect cameras on the network, even if
the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that
the controller is not able to detect new cameras on the network when it is in “Motors On” state. When
the VC is started stand-alone in RobotStudio it is automatically set to “Motors On“ when started.

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or launch the
VC as part of a station.

User tip - Removing cameras from configuration

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter
Configuration->Communication->Application Protocols and remove the desired camera. Perform a
warm start to complete the operation.

User tip – Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on
the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is
useful when error tracing camera network problems. If a camera does not appear on the network using
the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the
camera receives power from the controller, then cycle power by turning the mains switch.

User tip – Warm start the controller after changing network settings

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect-
>Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will
give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP
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address is used and persist, please try a static address instead.

Offline

Point cloud data in JT files can't be imported

Point cloud data in JT files is not imported by RobotStudio.

Issue with collission avoidance for palletizer robots

When configuring collision avoidance for a palletizer robot using RobotWare 6.11, attaching an object to
a mechanism link can result in an error and the configuration will not be loaded.

The YuMi library revision 1 cannot be successfully updated to YuMi revision 2

When opening a Pack&Go file with a station that has a reference to IRB14000_0.5_0.5__01.rslib  you
get the option to update it to the newer IRB14000_0.5_0.5__02.rslib .

The following issues occurs if you select ‘Yes’ and update the model:

The attached parts, for example Smart Grippers, are detached.
The new YuMi robot is not connected to the virtual Controller.
The old YuMi mecanism is converted to a component.

Answer ‘No’ to this question to keep the original revision 1 model and avoid the problems mentioned
above.

RobotStudio needs to be restarted to update a modified library instance

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be
restarted to update the library. Simply re-opening the station is not enough to update the content of
the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded
even though the underlying file has been updated. This is a known limitation and is expensive to fix.
There is a workaround to the problem, which is to restart RobotStudio.

The robot IRB 1600ID 1.55 m / 6kg replaced by IRB 1660ID1.55 m / 6 kg in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to
IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03
cannot upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on
RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically

Workaround: Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead
when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of

the logged-in Windows user. RAPID applications running in a background task will start to execute when
the Pack&Go file is opened and FlexPendant applications will start to execute when the user starts the
Virtual FlexPendant. A warning message has been added to the Unpack&Work wizard to make the user
aware that only Pack&Go files (.rspag) from trusted sources shall be opened.
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Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries
created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02
or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created
in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04

TrueMove path visualization fails for customized zone data

The TrueMove path visualization function only supports predefined zonedata. It will not work for user
defined zonedata.

Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution
when saving the station. For virtual controller systems with the RobotWare options SafeMove or
Electronic Positioning Switches the backup will fail since these systems contain files that are read-only.
As a result, an error message is presented in the output window: <System name>: Backup failed . The
station will be successfully saved but there will be no backup created. Workaround: Ignore the error
message <System name>: Backup failed  and create a manual backup whenever needed. The
RobotStudio Option “Enable automatic backup of controllers in solution” that is available in
”RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup
function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB
14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000

The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models
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As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the
update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or uncomment the following line in the file RobotStudio.exe.config

<add key=”DoublePresentWorkaround” value=”true” />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station
contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller
configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.

Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets
files in the folders:

…\My Documents\RobotStudio\Instruction Templates
…\My Documents\RobotStudio\Code snippets

Workaround: The user has to manually copy the latest files from

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates

and

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets

to the data folder.

I/O signals configured with access level 'DEFAULT'

When IO signals are configured with access level 'DEFAULT', only input signals are possible to set/reset
from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to
‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference
Interface) if the GSI folder structure is missing.

Workaround: Create GSI Folder before starting the VC inside the HOME directory of the system. See the
Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode.
This is the same behavior as in a physical robot controller system. This typically happens when a run-time
error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this
state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual
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mode, and then back to Automatic mode.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing
via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an
Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals.

Conveyor Tracking

*Conveyor objects must be re-added for stations created prior to RS 6.05

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects
must be re-added.

Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual
controller system. The symptom is that its attribute values are all zero, see snapshot below.

Workaround: Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual
controller followed by a restart.

EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
 -Name "c1Position" -SignalType "AI" -Unit "CnvIf"\
 -SignalLabel "ctPosition" -UnitMap "0-31" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647
 -Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -SignalLabel "ctSpeed"\
 -UnitMap "32-63" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647

MultiMove

MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be
displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status
‘Calculation OK’ is displayed. In addition, when ‘Create Paths‘ is pressed the following message is
displayed: ‘Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths
Settings’, is the WP TCP drop down empty.

Reason: Workobject is not set for the current task.

External Axis

Error 50091: ‘Restart not possible’ after warm start of a system with external axis

When restarting a system with activated mechanical units the activation state is lost. Then the program
can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the program from

© Copyright 2021 ABB. All rights reserved. 22/30



the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the
Simulation Play button.

Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents
folder resides on a server and not on the local disk.

Workaround: Redefine the ’User Project Folder’ to a folder on the local disk (File → Options → General →
Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will
cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts.
Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare
mediapool, the following problems may occur:

Virtual controller does not start
Not possible to open Virtual FlexPendant

Cause: By default, the .NET Framework does not allow execution of code from a remote file system. This
means the application may behave unexpectedly if the media used by the system or the system itself
resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in C:\Program Files (x86)\ABB Industrial
IT\Robotics IT\RobotStudio 5.61\Bin

2. Add the following lines:

<?xml version="1.0"?>
<configuration>
    <startup useLegacyV2RuntimeActivationPolicy="true">
        <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
    </startup>
    <runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
        <loadFromRemoteSources enabled="true"/> <!-- THIS IS ONE OF THE NEW LINES!!! -->
    </runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
</configuration>

The Virtual FlexPendant must be restarted for the changes to take effect. For further information, see
http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx

RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice
versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.
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Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly,
i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the
same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled
(PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data name type has same name as existing
object in same block routine.

When this error message appears, there is a storage type mix-up between data already stored in RS and
in the VC. Because of this, and per design, the data is not considered the same data.

Workaround:

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface
for this).

2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus,
will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

Graphics and Geometry

*Display of working range optimized for furthest reach

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The
sweep is not optimized to get the shortest reach on the "inside" of the working area.

© Copyright 2021 ABB. All rights reserved. 24/30



Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can
be configured to use a specified device. By this option you can ensure maximum performance. This is
useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA
card.

Open the file RobotStudio.exe.config that is located in the folders

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin64

and

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin

and uncomment the line:

<add key="GraphicsDeviceType" value="Discrete"/>

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer). Note that there are two different
files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete
the items that caused the problem.

ScreenMaker

Numeric controls and decimal separators

To use numeric controls in ScreenMaker on the PC set the decimal symbol to a single period ('.'). Other
decimal symbols are not supported and binding values will not work in the Virtual FlexPendant. The
behavior on the real FlexPendant is not affected by this PC setting.

Graphs on secondary screens

To use a Graph on a secondary screen (not the main screen) a custom action is needed. Otherwise, the
Graph will not be updated properly. In the ScreenForm that contains the Graph add a Load event. In this
event add an action using Add Action->Advanced->Call Custom Action. Select the Graph control and the
UpdateValues action.

© Copyright 2021 ABB. All rights reserved. 25/30



Binding to the Enabled property

Connecting the Enabled property of any control to a BOOL variable or IO signal may not work as
expected. The variable or signal may be inadvertently changed leading to unexpected behavior. Instead,
bind to a digital output where the Access Level is set to ReadOnly

A ScreenMaker cannot be deployed a controller with disabled Default User

Workaround: Enable the Default User.

NumEditor in ScreenMaker disables the controls in a group box or panel

If you are using the NumEditor control in a group box or a panel, and that box or panel is enabled by an
input signal, then all other controls of that group or panel will become disabled if the editor is opened
and closed.

Button with multiple states in ScreenMaker app do not update the images if button is disabled

For an app which uses Buttons with multiple states connected to images that change depending on the
value of a RAPID variable, then if the button is disabled, the button shows the greyed image of the state
which was active when the disabled state was shown the first time.

ScreenMaker fails for RobotWare 5.12

ScreenMaker fails to build applications for RobotWare 5.12.
Workaround: Update to a later RobotWare version.

A ScreenMaker application may fail to build if the DPI setting is not set to 100%

Certain UI controls in ScreenMaker may fail to build correctly if the DPI setting is not set to ‘Smaller –
100%’.
Symptom: The error message caused by this problem will read ‘System.Drawing.Font’ does not contain a
constructor that takes 2 arguments.
Workaround: Set DPI to 100% on your PC.

File changes to FlexPendant applications does not load the changes until a FlexPendant reset

With RobotWare 6.0x the controller's restart will no longer reset the FlexPendant memory. This was part
of an effort to improve the restart time of the controller. This means that after placing a new
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FlexPendant application file(s) on the FlexPendant unit, you need to manually reset the FlexPendant for
it to reload its assets.

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's backside. (See
Operating Manual – IRC5 with FlexPendant, 3HAC16590)

Running Routine with Movement

RunRoutine Button control does not always work correct when a routine with movements is called. As a
workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the
movements of the robot. A Trap routine could be called with a normal button control and in the Trap the
above instructions can be used to control the movements of the robot.

PictureBox control as a Widget

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not
shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
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RobotWare Compatibility

Supported RobotWare versions

RobotStudio works with RobotWare 5.07 and later. Please check details below. The latest supported
RobotWare version for IRC5 and OmniCore controllers is stated under Help/About in RobotStudio.
RobotWare packages can be added to RobotStudio from the RobotApps window.

RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later
versions. Please use the corresponding version of RobotStudio for managing robot controllers with any
of these RobotWare versions.

RobotWare 5.07 Compatibility

General

The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline

A limitation in the versions 5.07.02, 5.07.03, and, 5.07.04 of RobotWare may cause the Virtual Controller
to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not
being correctly created.
Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then
perform a warm start.
Note: The problem will reappear if the system is I-started. The virtual controller does not support
RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07.

RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:

Offline

RobotWare 5.08 is not supported.
Workaround: Use RobotWare 5.08.01 or later.

RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:

Offline

Starting a controller will generate internal UAS error in controller error log.

RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions of are supported with the following limitations:

Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example,
if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to
stop or to change configuration.
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RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.01 are not compatible with RW 5.12.02 or later. Restoring a paint system
backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later.
Workaround: Add the following parameters to the configuration files:
EIO.CFG

EIO_SIGNAL:
-Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
-Name "A1HVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"\
-Access "ALL"
-Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"\
-Access "ALL"

EIO_CROSS:
-Res "A1HVEn" -Act1 "HVEnabled"

SYS.CFG:

CAB_TASK_MODULES:
-File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"\
-Task "T_ROB1"
-File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask \
-Hidden

RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW
5.13.03. There are several changes in the configuration database for I/O (EIO.CFG) and Controller
(SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed
RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your
original backup, but do not load the backup.

2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file

comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-

system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are

not changed by the user).
7. Load the backup and restart the system. You are done.

RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.
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RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a
system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then
recreate the system and finally, restore the backup. For this reason, the functions ‘Unpack&Work’, ‘Go
Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent
upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01. RobotStudio, however, is compatible with
both RobotWare 6.00 / 6.00.01 and 6.01.

General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or
SafeMove can be done without the need to read track motion parameters manually when using
RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically
read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present
all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or
earlier is used.

Workaround: Upgrade to RW5.14.01 or later
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